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Released:  December 6, 1999
LOCATION AND MONITORING SERVICE
APPLICATION ACCEPTED FOR FILING

Auction Event No. 21
Pleading Cycle Established
Report No. AUC-21-N (Auction No. 21)

The FCC Form 601 (“long-form application”) of Progeny LMS, LLC (“Progeny LMS”) for multilateration Location and Monitoring Service (LMS) licenses listed in Attachment A has been found, upon initial review, accepted for filing.  The Commission may return or dismiss Progeny LMS's application if it is found, upon further examination, to be defective or not in conformance with the Commission's Rules.  See 47 C.F.R. § 90.161(b)(6). 


Progeny LMS was the winning bidder in 231 markets in the LMS auction, Auction No. 21.
  Progeny LMS initially filed a long-form application identifying Curtis Johnson as its CEO and contact person.
  The initial long-form application also identified Progeny Post and Lawrence Green as sole members of Progeny LMS.  The long-form application further indicated that Otto Frenzel had an indirect interest in Progeny Post and stated that Frenzel "loaned" approximately $1.35 million to Progeny Post and also executed a note to LMS Spectrum Partners, a subsidiary of Progeny LMS, for another $1.9 million.  


On April 28, 1999, Otto Frenzel filed an emergency motion for preliminary injunction in Indiana state court and simultaneously filed a motion for declaratory and injunctive relief.
  In addition, Frenzel requested that the Commission temporarily stay further processing of Progeny LMS’s long-form application.
  Both parties submitted documents to the Commission in support of their respective positions.  Progeny LMS has now filed an amended long-form application, which is accepted for filing.      


Petitions to deny the Progeny LMS application for licenses listed in Attachment A must be filed no later than December 16, 1999, which is ten (10) days after the date of this Public Notice.  See 47 C.F.R. § 1.2108(b).  Oppositions to a petition to deny must be filed no later than five (5) business days after the date on which the petition to deny is filed.  See 47 C.F.R. § 1.2108(c).  Replies to the opposition must be filed no later than five (5) business days after the date on which the opposition is filed.  See 47 C.F.R. § 1.2108(c).  All filings concerning Progeny LMS's long-form application should refer to Report No. AUC-21-N (Auction Event No. 21), as well as Progeny LMS's file number, 0000006894.


An original and four copies of all pleadings must be filed with the Commission's Secretary, Magalie Roman Salas, Office of the Secretary, Federal Communications Commission, 445 Twelfth Street, S.W., TW-A325, Washington, DC 20054, in accordance with Section 1.51(c) of the Commission's rules.  See 47 C.F.R. § 1.51(c).  In addition, one copy of each pleading must be delivered to each of the following locations: (1) the Commission's duplicating contractor, International Transcription Service, Inc. (ITS), 1231 20th Street, N.W., Washington, DC 20036; (2) Office of Media Relations, Public Reference Center, 445 Twelfth Street, S.W., Suite CY-A257, Washington, DC 20554; (3) Kenneth Burnley, Auctions and Industry Analysis Division, Wireless Telecommunications Bureau, 445 Twelfth Street, Suite 4-B524, Washington, DC 20554; and (4) Ronald Fuhrman, Licensing and Technical Analysis Branch, Commercial Wireless Division, Wireless Telecommunications Bureau, 1270 Fairfield Road, Gettysburg, PA  17325.


Progeny LMS's application is available to the public for electronic viewing.  Instructions for obtaining and using the Commission's Universal Licensing System ("ULS") are contained in Attachments B and C of this Public Notice.  Progeny LMS's application as well as documents relating to the court proceeding are also available to the public in the Office of Media Relations, Public Reference Center, 445 Twelfth Street, S.W., Suite CY-A257, Washington, DC.  The Public Reference Center is open Monday through Thursday, 9 a.m. to 4 p.m., and Friday, 9 a.m. to 2 p.m.  In addition, copies of the application may be obtained from ITS, 1231 20th Street, N.W., Washington, DC 20036, (202) 857-3800.


After the pleading cycle, the Wireless Telecommunications Bureau will release a public notice listing the licenses that the Commission is prepared to award in the event that it is determined that Progeny LMS's application conforms with applicable Commission rules.  Progeny LMS will be required to pay the balance of its winning bids in a lump sum payment within ten (10) business days following the release of that public notice.  See 47 C.F.R.§ 90.1015.  Licenses will be awarded upon the full and timely payment of the winning bids and any applicable late fees.


For technical assistance in using ULS for viewing applications or making amendments to applications, contact the FCC Technical Support Hotline at (202) 414-1250.  The FCC Technical Support Hotline generally will be available Monday through Friday, from 9 a.m. to 6 p.m. ET.  All calls to the FCC Technical Support Hotline are recorded.  


Questions regarding procedural issues should be directed to Kenneth Burnley at (202) 418-0664.

This document contains the following attachments:

Attachment A:   Applications Accepted for Filing

Attachment B:   Instructions for Searching for Applications listed in Attachment A

Attachment C:   Accessing the FCC Network Using Windows 95/98
Attachment B
INSTRUCTIONS FOR SEARCHING FOR 

APPLICATIONS FILED FOR AUCTION 21
This attachment provides instructions for electronically searching the FCC Network for a specific application or applications on file with the Commission.  The following instructions relate specifically to searching for applications filed in response to Auction 21.

To search the FCC Network for an application, you must first connect to the FCC Network.  Attachment C describes how Windows 95/98 users can connect to the FCC Network using the Dial-Up Networking features of Windows 95/98.

We recommend that you use Netscape Communicator 4.5 (Internet web browser software) to use ULS to electronically register and file FCC Form 601.

Note:  To download Netscape Communicator 4.5 free of charge, access the Netscape download site at http://home.netscape.com/download/. 

Conventions
The instructions in this attachment use the following typographic conventions:

bold

Represents objects on the screen that you click with the mouse pointer, including buttons, Internet links, icon, tabs, menu items (e.g., Cancel button, Auctions link, Save option in the File menu).

italic

Represents field names or areas of a screen (e.g., Licensee Name field, Applicant Information area of a screen).

bold italic
Represents characters that you must type exactly as they appear in the instructions.  For example, if you are instructed to type http://www.fcc.gov, you should type all of the characters shown in bold italic exactly as they are printed.

Small Caps
Represents keys on the keyboard (e.g., Enter, Ctrl, Esc).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then press the Enter key.

Performing an Application Search
Once you have connected to the FCC Network, follow the procedures below to search for an application.  You may click the ? (Help) button at anytime for additional information on using Application Search.
1.
Use Dial-Up Networking in Windows 95/98 to connect to the FCC Network (see Attachment C).


Note:  If your PC is connected to a network, you must use a secure proxy to access the FCC Network.  Consult your Network Administrator.
2.
Start your web browser.  Verify that Java and JavaScript are enabled in your web browser preferences.  Additionally, the preferences must specify “Accept all cookies.”  Refer to your web browser Help facility for more information.

3.
In the Netsite field of the web browser screen, type http://wtbwww05.fcc.gov.  Then press the Enter key.  This will access the Universal Licensing System main page.

4.
On the Universal Licensing System main page, click the Application Search button, located on the left side of the page.  The Application Search screen will then appear.  This screen contains several data entry fields used for specifying search criteria.

5.
On the Application Search screen, specify the search criteria necessary to locate the desired application.  Please refer to the following “Basic Guidelines for Specifying Search Criteria” for more information.  


If you are searching for an application filed for Auction 21, click 21 in the Auction ID field.


Basic Guidelines for Specifying Search Criteria:

(
You must specify search criteria in at least one field.  You do not have to specify search criteria in all of the search fields.  Enter search criteria into as many fields as you wish.


(
To specify search criteria in a search field containing a menu of options, click the desired option from the menu.   Use the scroll bars to view all options in a menu.  You can select multiple options from a menu by pressing the Ctrl key while you click the menu options. 


(
Click <No Criteria> to undo a menu selection and search for all options in the menu. 


(
Click the Clear button to reset entries in all of the search fields. 


(
The Universal Licensing System restricts the number of rows returned in an application search to 3000.


Click the ? (Help) button for a definition of each search field available on the Application Search screen.
6.
After you have specified the desired search criteria, click the Search button.  The system will scan the database for any applications matching the search criteria.  The matching application files will be listed on the Search Results screen.  The Search Results screen will identify the file number, licensee name, application purpose, application status, radio service code, and receipt date for each application returned in the query.


A message on the Search Results screen will indicate if no matches were found for the specified search criteria.  Click the New Search button and respecify search criteria.

7.
To view an application, click its file number link.  To navigate through the data on the Application screen, use the scroll bar or click the links at the top of the screen.  Click the ? (Help) button for information regarding specific functions available on this screen.

(
To re-access the Search Results screen, click the down arrow end of the Other Options field to obtain the drop-down menu of options.  Click Search Results from the Other Options menu and then click the Go button.


(
To begin a new search, click the down arrow end of the Other Options field to obtain the drop-down menu of options.  Click New Search and then click the Go button.

Technical Support
For technical assistance in searching the ULS for applications, contact the FCC Technical Support Hotline at (202) 414‑1250 (voice) or (202) 414-1255 (TTY).  The FCC Technical Support Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET.  All calls to the FCC Technical Support Hotline are recorded.

Attachment C

ACCESSING THE FCC NETWORK USING WINDOWS 95/98

This attachment describes how to access the FCC Network from a system that is running the Microsoft Windows 95 or Microsoft Windows 98 operating system.  This involves configuring dial-up network access and then performing the dial-up procedure.

Conventions
The instructions in this section use the following typographical conventions:

bold

Represents objects on the screen that you click with the mouse pointer, including buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link, Save option in the File menu).

italic

Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses area of a screen).

bold italic
Represents characters that you must type exactly as they appear in the instructions.  For example, if you are instructed to type http://wtbwww03.fcc.gov, you should type all of the characters shown in bold italic exactly as they are printed.

Small Caps
Represents keys on the keyboard (e.g., Enter, Ctrl, Esc).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then press the Enter key.

Hardware and Software Requirements
To connect to the FCC Network using Windows 95/98 Dial-Up Networking requires, at a minimum, the following hardware and software:

Hardware Requirements
(
CPU: Pentium or above

(
RAM:  16 MB (more recommended)

(
Hard Disk: 33 MB available disk space

(
Monitor:  VGA or above

(
Modem:  28.8 kbps or higher

(
Mouse or other pointing device

Software Requirements
(
Netscape Communicator 4.5 or 4.51

(
Microsoft Windows 95/98

Note:  If you are running Windows in a networked environment, check with your local network administrator for any potential conflicts with the Windows 95/98 Dial-Up Networking.  This usually includes any TCP/IP installed network protocol.  

The Windows 95/98 Dial-Up Networking will establish a direct connection from your PC to the FCC Network.  This point‑to‑point connection is not routed through the Internet.


Configuring Dial-Up Networking
1.
To start dial-up networking:


a.
Click the Windows 95/98 Start button.  


b.
Click the Programs option to display the Programs menu.


c.
Click the Accessories option to display the Accessories menu.


d.
In Windows 95, click Dial-Up Networking.



In Windows 98, click Communications, then Dial-Up Networking.


If Dial-Up Networking is not an option on your Accessories menu, you should install it from your Windows 95/98 CD or diskettes.

2.
When the Dial-Up Networking window appears, double-click the Make New Connection icon.

3.
The Make New Connection window appears.  In the field entitled Type a name for the computer you are dialing, type ULS at FCC. 

4.
In Windows 95, click the down arrow at the right of the Select a modem field and select your modem from the menu of available modems.  


In Windows 98, click the down arrow at the right of the Select a device field and select your modem from the menu of available devices.


If your modem does not appear on this list, you must install your modem driver according to the modem manufacturer installation procedures, which are usually described in your modem’s user manual.

5.
Click the Configure button.  Click the Options tab at the top of the Properties window.

6.
In the Connection control area of the Options tab, verify that neither option is selected.  If either option is selected, click the check box at the left of the option to deselect it.  Then click the OK button.

7.
Click the Next button.  

8.
Type 800 in the Area Code field and 844-2784 in the Telephone Number field.  Verify that the correct country is selected in the Country code field.  If necessary, click the down arrow at the right of the Country code field and select the appropriate country from the menu of available countries.

9.
Click the Next button.

10.
Click the Finish button.  An icon titled ULS at FCC appears in the Dial-Up Networking window.

11.
Verify that properties are configured correctly before attempting a dial-up session.  Position the mouse pointer on the ULS at FCC icon and click the right mouse button to display a menu.  Select Properties from the menu.

12.
Click the Server Types tab at the top of the Properties window.

13.
In the Advanced Options area, verify that only Enable software compression is selected.  


If it is not selected, click the check box at the left of the option to select it.  If either of the other options is selected, click the check box to deselect it.

14.
In the Allowed Network Protocols area, verify that only TCP/IP is selected.  


If it is not selected, click the check box at the left of the option to select it.  If either of the other options is selected, click the check box to deselect it.

15.
Click the TCP/IP Settings button and select Specify name server addresses.

16.
Type 192.104.54.1 as the Primary DNS.  

17.
Click OK on the TCP/IP Settings window and the Server Type window.

18.
a.
Click the Windows 95/98 Start button, then click the Settings option to display the Settings menu. 



b.
Click Control Panel and then double-click the Network icon. 



c.
Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties. 



d.
Click the DNS Configuration tab. 



e.
Select Enable DNS. Type bidder in the Host box, type fcc.gov in the Domain box,  then type 192.104.54.1 in the DNS Server Search Order box and click the Add button. 



f.
Click OK on the TCP/IP Properties windows, then click OK on the Network windows. 



g.
If you are prompted to restart your computer, click Yes to restart, then begin the Dial-Up Procedure.


Dial-Up Procedure
1.
If the Dial-Up Networking window is not currently open, do the following:


a.

Click the Windows 95/98 Start button.  


b.

Click the Programs option to display the Programs menu.


c.

Click the Accessories option to display the Accessories menu.


d.

In Windows 95, click Dial-Up Networking



In Windows 98, click Communications, then Dial-Up Networking.  


The Dial-Up Networking window appears.  

2.
Double-click the ULS at FCC icon in the Dial-Up Networking window.

3.
Click the Connect button on the window.  Do not enter User name and Password.


The Connection window appears, indicating the status of your connection as your modem dials into the system.  This window must remain running during your dial-up session.  You may minimize the window, if you wish.


If your modem fails to establish a connection, please see the Troubleshooting section below.

4.
Once the connection is established, open your Web browser.  

5.
In your browser’s Netsite field, enter http://wtbwww05.fcc.gov.


If nothing appears in your Web browser, please see the Troubleshooting section below.

6.
When you have finished, exit the Web browser, then click the Disconnect button on the Connection window to end your dial-up session.


Troubleshooting
Following are problems you may encounter and possible solutions for resolving or isolating them.

Modem does not respond
1.
Confirm that all physical connections for the modem are present.

2.
Confirm that the phone line is active by connecting it to a telephone and checking for a dial-tone.

3.
Confirm that the correct modem driver is installed for your modem. 

Modem dials but does not connect
1.
Confirm that the number the modem is dialing is correct.

2.
Confirm that the modem prefix, if any, is correct.

Modem dials and connects, but nothing appears when you enter the Netsite in the Web browser  
1.
Check the settings in your dial-up networking icon, particularly that the Primary DNS is 192.104.54.1 and that TCP/IP is the only selected protocol.

2.
Confirm that your web browser is using no proxies.

3.
If you do log into a TCP/IP LAN, confirm that your LAN network IP address is being released.  To do so, connect to the FCC Network using dial-up networking, then click the Start button in Windows 95/98 and select Run.  Type winipcfg and press OK.  If your IP address does not begin with “192.104.”, then your LAN IP address is not being released.  Click the Release All button, or consult you LAN administrator.

Receive an Internal Server error in the Web browser 
1.
Confirm that the address entered in the Netsite is correct (http://wtbwww05.fcc.gov).

2.
Confirm that JavaScript is enabled in your Web browser.


Technical Support
For technical assistance with installing or using FCC software, contact the FCC Technical Support Hotline at (202) 414‑1250 (voice) or (202) 414-1255 (TTY).  The FCC Technical Support Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET. All calls to the FCC Technical Support Hotline are recorded.




�	Progeny LMS subsequently defaulted in two of these markets.  A default payment order requiring Progeny LMS to formally withdraw winning bids for the Block B licenses in BEA107, Minneapolis-St. Paul, MN, and BEA164, Sacremento-Yolo, CA, was released on August 30, 1999.  See Order, DA 99-1731 (rel. August 30, 1999).


�	See Attachment A, Long-form Application of Progeny LMS, dated March 22, 1999.   


� 	See Verified Complaint for Expedited Declaratory Judgment and Injunctive Relief of Frenzel, Otto Frenzel, III and Progeny LMS, LLC v. Curtis L. Johnson and Progeny Post, LLC, Case No. 49D109904CP000599 (Marion Superior Court, Indiana, filed April 28, 1999).  See also Temporary Restraining Order and Notice of Hearing on Motion for Preliminary Injunction of Frenzel, dated April 28, 1999.  


� 	See Frenzel Request for Temporary Stay, filed July 2, 1999 (requesting the Commission to temporarily stay further processing of the Progeny LMS, LLC long-form application).  We dismiss this request for stay as moot.   







